Description

Simple Building Slab
Design

For LUSAS version: 18.0

For software product(s): | LUSAS Civil & Structural or LUSAS Bridge.

With product option(s): | None.

Note: The example as written exceeds the limits of the LUSAS Teaching and
Training Version. However, by not increasing the default mesh density to 8 divisions
per line (where shown) the analysis can be run using a default of 4 divisions per line.

Description
Four panels of a concrete slab Line Support
supported by a wall, columns and a T
lift shaft are to be analysed, with Panel A Panel B
reinforcement areas computed for
bending moment only. Shear and Slab Thickness 200mm 6m
displacement checks need to be | Soncrete o Nimn
carried out separately. The geometry Columns
of the slab is as shown. e
e
The slab is subjected to self-weight Panel ¢ Panel D
and a live load.
i i 2 < \ Line 6m
The units of the analysis are N, m, Supports

kg, s, C throughout.

et
Objective [} Il (] -
|
\

U To produce areas of } 6m

reinforcement under ultimate
loads and check crack widths under service loads

Keywords

2D, Plate, Slab Design, Holes, Reinforcement, Wood-Armer, RC Design, Steel Area, Load
Combinations, Smart Combinations, SLS, ULS, Beneficial, Adverse, Cracking
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Associated Files

U slab_design_modelling.vbs carries out the modelling of this example.

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller in
the Introduction to LUSAS Worked Examples document..

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command
File>New to start a new model file. Modeller will prompt for any unsaved data and
display the New Model dialog.

Creating a new model

o Enter the file name as Slab_Design

o Enter afile path for the working folder.

e Set the Analysis type to be Structural

e Set the Analysis Category to be 2D Grillage/Plate

e Select model units of N,m,kg,s,C

e Ensure the timescale units are Seconds

e Select the Startup template None from those available in the drop-down list.
e Enter the title as Slab Design Example

e Leave Layout grid set to None and click the OK button.

The Attributes &% treeview will be populated with potentially useful basic line mesh,
geometric and support entries appropriate to the settings made on the new model dialog.

Note. The Analysis category determines which elements will be available for
modelling. Here we are only interested in the out-of-plane bending effects in a flat slab
and therefore we can approximate this behaviour with 2D plate elements.

Note. Save the model regularly as the example progresses. Use the Undo button to
correct any mistakes made since the last save was done.




Modelling

Feature Geometry

G . .
| fs"u”;ZCZ > _I Enter coordinates of (0, 0), to define the lower
By Coords... left-hand area of slab, and using the Tab key to move
to the next entry field enter coordinates of (6, 0), (6, 6)
and (0, 6).
e With all the coordinates entered click the OK
button to create a surface.
Fiiy
e Select the newly created Surface.
|G§’$fi’e’ S M Copy the selected surface with an X translation
|Copy“, Of 6.
e Click the OK button to create the new Surface.
e Use Ctrl + A keys together to select the whole
model.
|G|eso$fztcz 3 M Copy the selected surfaces with a Y translation of 4
Copy... 6. b
e Click the OK button to define two new Surfaces.
Defining a Hole in a Slab
Next, a hole representing the lift shaft needs to be defined. This is done by first creating
a surface representing the extent of the lift shaft and then selecting both the surrounding
and inner surface to define the hole.
G .
[Geomety ~ 5] Enter coordinates of 2, 2), (4 2), (4 4) and (2,
By Coords... 4) and click OK to define the extent of the hole.
e Select the lower left Surface and then the Surface
representing the lift shaft. (Use the Shift key to
pick the second Surface to add to the selection)
| Geometry e Ensure Delete geometry defining holes is
Sugalce > selected A new singular Surface will be created. &
oles >
(Ceate _ This new surface containing the hole can be seen / B
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| File

Model Properties. ..

| Attributes

Mesh >
Surface...

| Attributes

Mesh >
Line...

Simple Building Slab Design

checked by clicking in a blank part of the Graphics Window and then re-selecting the
lower-left hand surface.

Note. It is normally good practice to ensure that the orientation of surface axes (and
hence mesh element orientation) is consistent throughout the model. However, plate
elements, as used in this example, produce results based upon global axes and as such
ignore inconsistent element axes.

Meshing

By default lines normally have 4 mesh divisions per line. If you are using the Teaching
and Training version this default value should be left unaltered to create a surface
element mesh within the limit available. This will give a coarser mesh and
correspondingly less accurate results will be obtained. Otherwise, for this example, and
to give greater accuracy, 8 divisions per line will be used.

e Select the Meshing tab and set the default number of divisions to 8 and click the
OK button.

e Select the element type as Thick Plate, the element shape as Triangle and the
interpolation order as Quadratic. Select an Irregular mesh and ensure the
Element size is deselected. This forces the number of default line mesh divisions to
be used when meshing the surfaces. Enter the attribute name as Thick Plate and
click the OK button.

e With the whole model selected drag and drop

the mesh attribute Thick Plate from the &
Treeview onto the selected Surfaces [

In the vicinity of the lift core less elements are
required.

e Select the element type as None and enter the
Number of divisions as 4. Enter the attribute
name as Divisions=4 and the OK button

e Select the 4 lines defining the lift core and drag B

and drop the line mesh attribute Divisions=4 from the & Treeview onto the
selected Lines.

In this manner the mesh density on slabs can be varied according to the levels of detail
required.




| Attributes

Modelling

| Geometric

Surface...

| Attributes

>

| Material

| Material Library...

| Attributes

>

| Support...

Geometric Properties

Enter a thickness of 0.2. Enter the attribute name as Thickness 200mm and click
the OK button.

With the whole model selected drag and drop the geometric attribute Thickness
200mm from the € Treeview onto the selected Surfaces.

Geometric properties are visualised by default.

In the =¥ Treeview drag and re-order the layers so that the Attributes layer is at the
top of the Treeview, followed by the Mesh layer, followed by the Geometry layer.
Delete the Utilities and Deformed mesh layers if present by right clicking and
selecting Delete.

ll Select the fleshing on/off button to turn-off the geometric visualisation.

Material Properties

Select material type Concrete, region Europe, standard EN1992-1-1:2004/2014
and grade C40/50 and click OK to add the material attribute to the & Treeview.

Select the whole model and drag and drop the material attribute Isol (C40/50
Concrete EN1992-1-1:2014) from the & Treeview onto the selected Surfaces.

Supports
Select Fixed for Translation in Z and enter the
attribute name Fixed in Z and click OK. §§:ﬁtcst mse

For clarity the mesh layer is not shown on these

diagrams, // % %

assign Fixed in Z

Select the 6 points where the columns are located.

Assign the supports by dragging and dropping the
support attribute Fixed in Z from the & %i s
Treeview and assign to All analysis loadcases by i

clicking the OK button.
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e Select the 2 Lines representing the line support

and drag and drop the support attribute Fixed in H
Z from the &b Treeview and assign to All Select these 2
analysis loadcases by clicking the OK button. t:;‘:j ?:‘imgn

e Select only the top, bottom, and left-hand lines
defining the lift shaft and drag and drop the . Select these 3
support attribute Fixed in Z from the & %} Linesand assign
Treeview and assign to All analysis loadcases by ' Fixedinz
clicking the OK button.

El Select the isometric view
button to check that all supports
have been assigned correctly.

< NAA Click this part of the

status bar to view the model from
the Z direction again.

Loading
| Attributes e Select Body Force and click Next.
Loading...
e Enter an acceleration of -9.81 in the Z direction.
e Enter an attribute name of Self Weight and click the Finish button.
| Attributes e Select the Global Distributed radio button and click Next.
Loading...

e Select the Per unit area option.
e Enter -5000 in the Z Direction.

e Enter the attribute name as Imposed Load 5kN/m2 and click the Finish button.




Modelling

Now the dead and live loading needs to be %
assigned to each slab panel of the building. This
is done using separate load cases so that the
loadcases can be combined to determine the
most adverse effects.

In the Analyses (L) Treeview, right click on - AN ¥

Analysis 1 > Loadcase 1, select the
Rename option and change the loadcase
name to Panel A Permanent

Select the surface representing the top left-
hand panel (Panel A). =

Assign the dead loading by dragging and dropping the attribute Self Weight from
the & Treeview onto the selection. The loading assignment dialog will be
displayed. Select the Single Loadcase option, the analysis Analysis 1 and loadcase
Panel A Permanent, then click the OK button.

Note. The loading assigned to each panel will be visualised for each loadcase as it is
assigned to the model

Drag and drop the dataset Imposed Load 5kN/m2 from the &b Treeview onto the
selection, accepting all defaults, and change the loadcase name to Panel A Variable
and click the OK button.

Select the top right-hand panel (Panel B).

Assign the dead loading by dragging and dropping the attribute Self Weight from

the &b Treeview onto the selection, accepting all defaults, and change the loadcase
name to Panel B Permanent Leave the load factor as 1 and click the OK button.

Drag and drop the attribute Imposed Load 5kN/m2 from the & Treeview onto the
selection and change the loadcase name to Panel B Variable and click the OK
button.

Select the bottom-left panel (Panel C).

Assign the dead loading by dragging and dropping the attribute Self Weight from
the &% Treeview onto the selection. Change the loadcase name to Panel C
Permanent and click the OK button.

Drag and drop the attribute Imposed Load 5kN/m2 from the &b Treeview onto the
selection. Change the loadcase name to Panel C Variable and click the OK button.

Select the bottom right-hand panel (Panel D).




| File

Save
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e Assign the dead loading by dragging and dropping the attribute Self Weight from

the &% Treeview onto the selection. Change the loadcase name to Panel D
Permanent and click the OK button.

e Drag and drop the attribute Imposed Load
5kN/m2 from the & Treeview onto the
selection. Change the loadcase name to ]
Panel D Variable and click the OK button.

The ‘2 Treeview should now contain eight {
loadcases consisting of a Permanent and !
Variable loadcase for each panel.

Saving the model

El Save the model file. =2

Running the Analysis

A

With the model loaded:

:l Select the Solve Now button from the toolbar and click OK to run the analysis.

A LUSAS Datafile will be created from the model information. LUSAS Solver uses this
datafile to perform the analysis.

If the analysis is successful...
Analysis loadcase results are added to the (X Treeview.
Addition files will be created in the directory where the model file resides, including:

U slab_design.out this output file contains details of model data, assigned
attributes and selected statistics of the analysis.

O slab_design.mys this is the LUSAS results file which is loaded automatically
into the ™= Treeview to allow results processing to take place.

If the analysis fails...

If the analysis fails, information relating to the nature of the error encountered can be
written to an output file in addition to the text output window. Any errors listed in the
text output window should be corrected in LUSAS Modeller before saving the model
and re-running the analysis.




| File
New...
| File
Script >
Run Script...

Viewing the Results

Rebuilding a Model

If it proves impossible for you to correct the errors reported a file is provided to enable
you to re-create the model from scratch and run an analysis successfully.

O slab_design_modelling.vbs carries out the modelling of the example.

Ql Start a new model file. If an existing model is open, Modeller will prompt for
unsaved data to be saved before opening the new file.

o Enter the file name as Slab_Design
e To recreate the model, select the file slab_design_modelling.vbs located in the

\<LUSAS Installation Folder>\Examples\Modeller directory.

=
;l Rerun the analysis to generate the results.

Viewing the Results

Analysis loadcase results are present in the () Treeview and load case results for the
last solved loadcase are set to be active by default.

e Turn off the Attributes layer
in the = Treeview.

e In the G Treeview right-click
on results loadcase Panel A Hrmsisdguniil
Permanent and choose Set
active

e With no features selected, click
the right-hand mouse button in
a blank part of the active
window and select the -

Contours option to add the contours layer to the & Treeview.

.

e Select entity Force/Moment and results component MX to see the results for
Permanent effects in Panel A.

Wood-Armer Results

Slab design will be carried out based on the Wood-Armer moments in the slab. These
results are computed from the orientation of the reinforcement, so the reinforcement

9



| Attributes

Design >
RC Slab Design...
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capacities/details must be defined and assigned to the model before results can be made
available. Two attributes are available from which Wood-Armer moments can be
calculated, and these are accessed from the Attributes > Wood Armer and Attributes >
Design > RC Slab Design menu items. Since we are going to carry out slab design
calculations we will create an RC Slab Design attribute.

Defining RC Slab design attribute

e From the Reinforcement
Library select bar sizes
as Metric.

e Set all bar sizes as
12mm and leave the
spacing as 150mm.

e Set the top and bottom
cover to be 20mm.

e Ensure the angle of bars
in y' from bars in x is
set to be 90°

e Enter the attribute name
as Slab and click OK.

B [ <]
Analysis category R layout
i library
‘ Barsizes  [Wleto =] o e Toplayer 1
detals R
e Fe ', «
~Top Face L A °
Basinx [layer1 v] [lZom x| [1500  mm * ‘( i
Fene B2 Zom =] [1500 | mm l T?D layer 2
z Yy o
—Bottom Face 0 |
Barsinx [lsyer1 7] [1Zom =] [1500 | mm I :
Barsiny [Layer2 [izom =] [1500 | mm NG |
- ol ! i
ars
Cover Top [200 Bottom |20.0 mm ny A Bot_torn layer 2
I™ Use nominal cover in crack width calculations . i
Nominal cover Top [20.0 Bottom [20.0 mm P
Orientation ;
’7Angleufbarsir|y'ﬁnmbarsinx 50.0 ‘
Name | Slab - él(n
Close || Cancel | Aoty || hep

Assigning RC slab design attribute
e Select the whole model and drag and drop the RC Slab attribute Slab (T[C=20mm,

DiaX=12mm,

DiaY=12mm],

B[C=20mm,

DiaX=12mm,

Skew=90) from the &b Treeview onto the selected Surfaces.

DiaY=12mm],

Note. Assigning the RC Slab attribute adds a new results entity Wood Armer to the

available results.

10




| Analyses

Viewing the Results

Smart

Combination...

e In the Treeview
right-click on Contours
and choose Properties

e Set the Entity as Wood
Armer and Component
as MX(B), click OK to
close the dialog and plot
the contours

A
L ermanent
Results fle: Siab_Design-Analysis
Entity: Wood -Armer - Thick Plate
Companent: MX(B] (Units: N.mim)

Defining Load Combinations

The loadcases will be combined to provide the most adverse loading effects. This is
achieved using the smart load combination facility within LUSAS Modeller.

Ultimate Limit State (ULS) design to EN1990:2002 requires permanent actions to be
factored by 1.0 where they are beneficial, and 1.35 where they are adverse. Variable
actions are omitted where beneficial, and are factored by 1.5 where adverse. (These
factors may be subject to national variation).

ULS design

e Include all loadcases in the smart combination. To do this select the first load case
in the loadcase selector at the bottom-left of the then hold the Shift key down and
scroll down the list and select the last loadcase.

e Click the LI button to add these loadcases to the included list.

e In the grid set the beneficial and adverse factors as shown in bold text in the table

that follows:

11
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Combination...
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Name Beneficial Factor Adverse Factor
Panel A Permanent 1 1.35
Panel A Variable 0 15
Panel B Permanent 1 1.35
Panel B Variable 0 15
Panel C Permanent 1 1.35
Panel C Variable 0 15
Panel D Permanent 1 1.35
Panel D Variable 0 15

e Change the smart combination name to ULS

e Click the OK button to complete the definition of the smart combination.

A maximum and a minimum smart combination entry will be created in the (&
Treeview. The maximum combination will produce the most adverse hogging moments
whilst the minimum combination will produce the most adverse sagging moments.

Note. When the properties of the max combination are modified the corresponding

min combination is updated automatically.

SLS design

For SLS Design, calculation of crack widths will be based on service loads and hence a

second combination is required.

e Include all the results loadcases (but not the two ULS combinations) in the Smart
combination. To do this select the first load case in the loadcase selector at the
bottom-left of the then hold the Shift key down and scroll down the list and select

the last loadcase.

e Click the LI button to add these loadcases to the included list.

e Enter the beneficial and adverse load factors in the grid as follows

12




Viewing the Results

Name Beneficial Adverse

Factor Factor
Panel A Permanent 1 1
Panel A Variable 0 1
Panel B Permanent 1 1
Panel B Variable 0 1
Panel C Permanent 1 1
Panel C Variable 0 1
Panel D Permanent 1 1
Panel D Variable 0 1

e Change the smart combination name to SLS
e Click the OK button to complete the definition of the smart combination

e Select ULS (Min)  comeiningon: mx
H UL'S('M”LJO rmer - ic

from the ‘5! Treeview Sl iectpmer nekpee
with  the right-hand l-74-“81E3
-57.G474E3
-49.4121E3
the Set Active option. -320414E3
. -B.23535E3

e In the Set Active Maximum 0.0 at node 16

X -G5.8828E3
mouse button and pick 49412163
-16.4707E3
. Minimum -74.1181E3 at node 45
dialog ensure Max/

min primary
component with
coincident effects is
selected.

e Select entity Force/Moment and results component MX to combine, applying the
variable factors based on the minimum moments in the X direction and click the
OK button.

Caution. Whilst not a problem with this example, note that if you use smart
combinations with ‘derived components’ you may not obtain the expected results. The
online help provides details of such circumstances which you should fully understand
before using this facility. In this worked example, a linear primary component is being
used to create the smart combination from which the Wood-Armer values will be

13
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| RC Slab Design...
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computed. It will be necessary to carry out design checks using primary components in
both directions (X and Y) to ensure the most onerous combination is found.

Using the RC Slab Design facility

The RC Slab design facility enables calculation of required steel reinforcement areas
for ULS loadcases and calculation of crack widths for SLS loadcases. ULS
reinforcement design is based on calculated Wood-Armer moments whereas crack
width calculations are based on principal moments. The effective depth is computed
from the top and bottom reinforcement bar sizes and covers provided in the RC Slab
attribute.

Caution. This example uses an irregular mesh of thick plate elements and for these
elements the results are output in global directions that, in this case, match the intended
reinforcement directions. In other modelling situations, if the elements in a model are
orientated such that their local axes vary from one another, or if an alternative
coordinate system is required, the results will need to be transformed to a consistent
direction. This can be achieved by either setting a local coordinate set or choosing an
appropriate results transformation option on a results layer property dialog prior to
opening the RC Slab Designer.

RC Slab Design: Design Code Settings

e Ensure that United Kingdom
and BS EN 1992-1- [ 3
1:2004/NA:2005 are selected Desincode  [is eN 1ooz 1 Z0anAZo0 =l
from the dropdown list of
countries and design codes j
e Change the Characteristic yield
strength of the reinforcement to l':
460 and ensure the O =
Characteristic cylinder strength ,":ZIWE
of concrete is 40 P
e Click Next to proceed to the = e e e

Crack Width Settings page.

Note. For 2D plate models the design calculations options are set to bending only. For
a 3D model comprising shell elements, slab design can be carried out considering in-
plane effects as well as bending.

14



Viewing the Results

e Ensure the crack width settings ~SER=EEEEEEEEE —
are as shown on the adjacent = Usocode efnedvles
d |a| Og Allowable crack width (mm) o3 Creep cosfficient (Phi) 2z
. Aggregate type: Quartzite -
i 0 Userdefinedvalies —————————————
e Click the Finish button to close (“*‘“"” o= imeelee | | o o ofcorcreGra 550
the dlalog "~ Effective elastic modulus for concrete Long term modulus of concrete GPa [0
. * Quasi-permanent
" Interpolated. based on proportion (et ez
Two new results entities Slab Vi ks Tl eiects (4 [00— 3”""‘?’:‘““’“""(% l_
. . Permanent efiects: Total effects (%) [200 S
Design (ULS) and Slab Design "™ Coctirtorsain tn ) [05——
- H T R — Coeffcient for cover influsnce: (K3)
(SLS) Wlll now be available -for IPermanemeifemfram\cadcaseorwmbmauonj o T o (g (g
selt_ac_tl_on in all results processing Tre sl gt et oty Cosfcent o bardomelr (). o5
facilities. e e
Defaults <Back Next Finish |[ Cancel | Hep |

Viewing results for bottom face of slab

With loadcase ULS (Min) still
set active in the @ Treeview: Elﬁtsut;Mllané Slab (ULS) - BS EN 1992-1-1:2004/NA:2005

Combining on: MX

Component: UtilMax(B)

i . 0.0
In the Treeview double- .g;ggggs

click on the Contours layer 0.508426
and select entity RC Slab T oieas
(ULS) — BS EN 1092-1- g iséts
1:2004/NA2005 and  Vinmum 0.0 st neae 17 "

component UtilMax(B).

It can be seen that the utilisation is exceeded by approximately 51%.

Note. UtilMax(B) provides the maximum of two utilisations Util(Mx(B)) and
Util(My(B)). The first is based on the Wood Armer component MX(B) and the slab
bending capacity in the that direction. The second is based on MY(B) and the
corresponding capacity in that direction. Individual utilisations may be viewed with
respective components Util(Mx(B)) and Util(My(B)).

Plotting contours of bottom reinforcement area

In the Treeview double-click on the Contours layer and change the contour
results component to Asx(B) to determine the area of steel required in the bottom
layer x direction. A steel area of 1135mm#m is required, which can be
accommodated by using 16mm bars at 150mm centres.

15
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Changing bottom reinforcement bar sizes

A check is also required that the
same face is adequate when the

In the €% Treeview double click the RC Slab attribute Slab and change the bottom
bar diameters used in the bottom face to be 16mm in both the x and y* directions.
The slab design will be recomputed.

In the Treeview double-  combining on: mx

ULS (Min)

click on the Contours Iayer Entity: RC Slab (ULS) - BS EN 1992-1-1. 2004/NA: 2005

Component: UtilMax(B)

and select results component .(,_0
UtilMax(B). A  maximum 0204228

0.306337

utilisation of around 0.92 can D-408ds,

be seen, so the bottom E:E}EEQ?
reinforcement is now @im 0513012 2t node 90
adequate. inimum at node

smart combination is optimised for MY

Select ULS (Min) from the @ Treeview with the right-hand mouse button and pick
the Set Active option.

In the Set Active dialog set the primary component to be MY and check that this
combination is also satisfied. A maximum utilisation of just under 0.95 is seen.

Viewing results for top face of slab

The viewing results process described previously needs to be repeated for the top face
of the slab, using the combination that will generate the maximum effects in the top
face:

Select ULS (Max) from the (X Treeview with the right-hand mouse button and pick
the Set Active option.

In the Set Active dialog select Max / min primary component with coincident
effects entity Force/Moment and results component MX to combine, applying the
variable factors based on the moments in the X direction and click the OK button.

In the Treeview double-click on the Contours layer and select entity RC Slab
(ULS) — BS EN 1992-1-1:2004/NA:2005 and component UtilMax(T).

Here the utilisation is exceeded around the central support. To determine how
widespread the problem is the contour range will be modified:

16



Viewing the Results

e Double-click the contours

layer in the Treeview,
select the Contour Range
tab, check the maximum
option and enter 1.0, and
then click OK. The adjacent
image shows the extent of
the problem.

Combining on: MX

ULS (Max)

Entity: RC Slab (ULS) - BS EN 199
Component: UtilMax(T)

0.0

012
0.25
0.37
0.5

0.62
0.75
0.87

3

1.0
|
Maximum 4.01757 at node 708

Minimum 0.0 at node 22

Changing top reinforcement bar sizes

e Repeat the procedure of
changing the reinforcement
bar sizes for the top layer
from 12mm diameter to .S'Emss
16mm diameter bars. The 054112
extent of the failure is 108224
reduced and now much 1.52338
more localised around the
central support.

Combining on: MX

ULS (Max)

Entity: RC Slab (ULS) - BS EN 199
Component: UtiiMax(T)

216448

Maximum 2.43504 at node 708
Minimum 0.0 at node 22

e Revisit the contours layer
properties and remove the
maximum value for the contour range. Whilst the utilisation is greater than 1, the
area of which this value occurs is very localised.

Note. Whilst it is tempting to increase the size of the reinforcement further it is
important to understand the limitations of the idealised analysis model. Very high
moments are generated at the point support. In reality this support will have some width
which will reduce the support moments. It is possible that the model could be refined to
account for these support conditions, alternatively the designer should satisfy
him/herself, through hand calculation or otherwise, that the forces and moments in the
actual configuration (accounting for column sizes and drops etc) can be satisfied.

Caution. The ULS design of reinforcement assumes that the slab is “under-
reinforced” and therefore the calculations are only valid when this holds true. The
contour plots Util(tex(T)), Util(tcy(T)), Util(tex(B)) and Util(tcy(B))  provide
utilisations on Tension Control and indicate whether the slab will undergo ductile
failure and is hence “under-reinforced.” Plots of Tension Control must therefore be
checked to ensure a valid design. For more information see the online help.
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Concrete crack checking

The calculation of crack widths in the RC Slab Design facility is based on principal
moments rather than Wood-Armer moments as used in reinforcement design. Effective
steel areas are interpolated based on the orientation of the principal moments with
respect to the steel bar directions. Extensive coverage of the crack calculation
procedure is provided in the Application Manual (Bridge, Civil & Structural).

Crack width checking (bottom face)
e Select SLS (Min)

from  the Someing o WX
H H Entity: RC Slab (SLS) - BS EN 199§
TreeVIeW Wlth the anl'lgonent: %W‘Maxt’BJ (Units: mm
right-hand ~ mouse . 0.0
button and pick the 0 0384553
Set Active option. 0 1ende.
¢ e
e In the Set Active B b-204481
dialog set  the  maximum 0262904 at nods 78
H inimum U.0 at node
primary component " 0.0 atnode 17

to be MX

e In the Treeview
double-click on the Contours layer and select entity RC Slab (SLS) — BS EN
1992-1-1:2004/NA2005 and component CWMax(B). This displays the maximum
crack widths calculated in the bottom face.

Note. A warning message is displayed when the effective steel stress calculated
exceeds the nominal yield value. Only the maximum value is reported along with the
face at which that occurs but it is possible that the maximum value may be exceeded in
both faces. In this example the maximum steel stress reported arises from hogging over
the central support.

The crack widths in the bottom face are found to be within acceptable limits. The top
face now needs to be checked.
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Viewing the Results

Crack width checking (top face)

e Select SLS (Max) from

the (5 Treeview with Smting o Mx
- Entity: RC Slab (SLS) - BS EN 199
the rlght-hand MOUSE  Component: CWMax(T) (Units: mm

button and pick the Set .o.o

- . 0.0826786
Active option. 0.165357

0.248036
0330714
0.413383

e In the Set Active dialog 0 496072
set the primary g 0551429
component to be MX Minimum 0.0 ot node 22 00

e In the Treeview
double-click on the
Contours layer and select entity RC Slab (SLS) — BS EN 1992-1-1:2004/NA2005
and component CWMax(T). This displays the maximum crack widths calculated in
the bottom face.

It can be seen that the over-utilised area is concentrated around the idealised support
condition and the designer must determine the validity of this assessment.

Note. The crack checking calculations are based on strains calculated from an
interpolated effective area of steel. However the actual crack width is calculated taking
the bar spacing and bar diameter of the layer orientated closest to the principal moment
in question. Contour plots for crack widths “controlled” by each reinforcement layer are
provided to identify exactly which bars are controlling the cracks. By default the
maximum crack width is displayed.

Note. Slab design results will be available as a results entity until they are turned off

by selecting “None” on the slab design dialog.

Save the model
El Save the model file.

Note. All the Slab Designer inputs are saved to the model and will be saved when the
model is saved. All load combinations, envelopes, and graph datasets, if defined when
processing results, are also saved and therefore do not have to be re-created if the
model is amended and a re-analysis is done at a later date.

This completes the example.
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Discussion

Simple Building Slab Design

Element types and orientation of results

The orientation of the slab reinforcement is aligned with the results axes. In this
example thick plate elements are used whose results axes are always transformed to the
global directions.

If shell elements are used (when appropriate) the results must be transformed into a
consistent direction coinciding with the intended direction of the reinforcement. By
default shell results are orientated along the local element axes.

The following result contours shows the indicative difference between results from
global (left) and local (right) axes for a ULS(Max) MX(B) plot.

Global Axes Local Axes

e The mesh orientation can be viewed from the Treeview by selecting Mesh >
Properties and selecting the Show Element Axis option. Press OK to apply
changes.

e Results transformations can be applied using the Transform Set... button on a results
layer’s Properties dialog. Selecting Global axes will transform local element results
into the global axes system. Other options are available..

e Global results are indicated by the uppercase X, Y and Z in the component names,
whereas lowercase X, y and z (when seen) are used to denote local results or
transformed results.
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Discussion

Element density and results obtained

If the Evaluation Version of LUSAS was used to carry out this example with a reduced

default mesh density of 4 divisions per line a slightly reduced accuracy of results will

have been obtained.

The following graph for ULS(Min) shows how Bending Moment (MX) along a

horizontal 2D slice section through the central three columns typically varies with the

number of line mesh divisions used.
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In general, more accurate results are obtained when using more line mesh divisions and
hence more elements when modelling slabs of this type. Care should always be taken to

use an appropriate number of elements together with a possible refinement of the mesh

in areas of interest in order to obtain the best results.
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